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     Звісно, етикетка ніколи не була важливішою за сам продукт, але ніхто не буде сперечатись, що вона — невід’ємна частина сучасного товару. Розглянемо етикетку не як малозначущий додаток до товару, а як потужний маркетинговий інструмент. У цьому випадку останній — важливе джерело інформації про продукт, виробника, вміст, термін зберігання тощо. Етикетка безперечно є “обличчям” продукту, “адже зустрічають по одягу”. Ось цей “одяг” і допомагає (або, навпаки, заважає) неуважному погляду споживача звернути увагу на потрібний товар серед строкатого розмаїття магазинних полиць. “Розумна” етикетка виділяє продукт із числа йому подібних, і при інших рівних умовах, завдяки цьому споживач надає перевагу продукту.

Етикетка виконує багато функцій, серед них інформативна — надання інформації про виробника, склад продукту, терміни вживання тощо, репрезентативна — подання самого продукту споживачеві, комунікативна — іміджева. Етикетка – це і плакат, і інформаційний листок, і все це в однобічному малоформатному багатоколірному виданні високої якості. Звичайно, є й одноколірні чисто інформаційні етикетки.

Досвід багатьох провідних марок довів, наскільки міцний повинен бути 

зв’язок між іміджем продукту та його успіхом на ринку. Тріада “імідж-етикетка / упаковка-товар” повинна бути відповідною у кожному пункті, і саме така тріада лежить в основі успішного просування товару на ринку.

   Подивимося на етикетку очима технолога-поліграфіста і побачимо: 

( багатоколірний друк високої якості; 

( яскраві і чисті кольори штрихових зображень, тексту і плашок; 

( якісні напівтонові (растрові) зображення; 

( виворотку, друк по вивороті; 
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( дрібний текст, а іноді і мікротекст; 

( тиснення, припресовування фольги і голограм, фігурну висічку самої етикетки і мікровисічку на етикетці (при спробі переклеювання етикетки з оригіналу на підробку завдяки мікровисічці етикетка розшарується). 

   І це все на одній етикетці, і всі разом, і на самих різних матеріалах, що задруковуються. 

   По розмаїтості матеріалів, що задруковуються, етикетку випереджає тільки пакування. 

   У розмаїтості, використаних в одному виданні (продукті) технологій і матеріалів, і складається проблема виробництва етикеток.

   Однак етикетки виготовляють, і виготовляють якісно, і красиво, і у великій кількості і розмаїтості. 

   Отже, проблема виробництва етикетки зважується на практиці.

   Будь-яка технологія в поліграфії базується на одному зі способів друку. В даному курсовому проекті запроектовано технологію виготовлення офсетних форм з використанням КВС для друкування етикеток.   

Сьогодні офсетний спосіб друку найпоширеніший, найбільш розвинений і забезпечений різноманітним устаткуванням, матеріалами і технологіями.

Офсетні технології вигідні при кожному (дрібному, середньому чи масовому) виробництві, коли вимоги до якості дуже високі і коли етикетки 

виготовляють на папері, тонкому картоні, металізованому папері і самоклеючих матеріалах. І чим менше післядрукарських операцій, таких як тиснення, припресовування фольги і голограм, фігурна висічка і мікровисічка, тим ефективніше ця технологія. 

Поліграфічні технології перебувають у постійному розвитку. Друкарський процес завтрашнього дня буде здійснюватися за допомогою цифрових даних-зображень або графіків.

Якщо розглядати процеси складання і репродукції, то можна сміливо стверджувати, що тут, завдяки комп’ютеризації додрукарських процесів,
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 відбулась “революція” цифрової техніки. Нині тенденція застосування цієї технології переважає також при виготовленні друкарських форм і в самому друкарському процесі. Перелік способів обробки і передачі даних на друкарський матеріал постійно розширюється.

Нині, завдяки комп’ютеризації, значна частина друкарських процесів стала автоматизованою. Обробка тексту і його складання, репродукційні роботи і обробка ілюстрацій, виготовлення ескізу і суміщення тексту й ілюстрацій, кольороподіл і растрування, монтаж шпальти, копіювання і спуск сторінок — всі ці роботи здійснюються з допомогою комп’ютера.

При класичному способі виготовлення друкарських форм потрібні великі затрати часу. Незважаючи на те, що друкарні отримують більшість ілюстрацій і текстів у вже цифровій формі, монтаж шпальти і спуск сторінок здійснюється ще вручну. Цілосторінкові плівки в даному випадку донині все ще є винятком.

У зв’язку з автоматизацією друкарських машин, яка відбулася за останні роки, стало можливим підвищення рентабельності в ділянці монтажних і копіювальних робіт. Сучасні умови праці при класичному способі виготовлення друкарських форм не задовольняють вимоги практики. Монтажні роботи, виконувані вручну, здійснюються з недостатньою точністю. Копіювальні машини працюють з низькою швидкістю. Запорошеність теж являє собою проблему. Коливання 
температур, а також відносної вологості повітря призводить до деформації плівок. Плівки, які містять галогеніди срібла, розчини для проявлення і фіксування у багатьох країнах вважають небезпечними відходами. Окрім того, потрібне скорочення затрат часу на виконання замовлень, а також зниження витрат на обслуговування замовлень, а також зниження витрат на обслуговувальний персонал і на додрукарські процеси в цілому.

При застосуванні технології Computer-to-film великоформатні пристрої експонування, які діють на основі системи PostScript, управляються 
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програмами, які гарантують отримання цілої друкарської фотоформи. Якщо для здійснення дорогого і не надто надійного ручного монтажу часом потрібен цілий тиждень, то електронний монтаж здійснюється протягом кількох годин.

Спуск шпальт здійснюється автоматично у відповідності з умовами друку і палітурно-брошурувальних робіт. Часто застосовувані зразки зберігаються в бібліотеці. Позначки для фальцювання і різання й інші позначки відбитка, а також контрольні шкали і суміщувальні позначки системи створюються і розміщуються електронним способом. Просічення плівки повного відбитка в пристрої експонування гарантує його ефективне використання.

Зараз поліграфічні підприємства все частіше отримують замовлення вже в цифровому вигляді. Ця інформація міститься на різних носіях даних у формі файлів тексту, ескізу, зображення. Правильність експонування гарантується тільки тоді, коли ці дані перед застосуванням перевіряє оператор.

Етикетка повинна не лише виконувати свої основні функції, а й захищати якісний товар від підробок, що нині особливо актуально. Щоб задовольнити високі вимоги, які зараз висуваються до етикетки, вона повинна друкуватися на папері, який відповідав би цим вимогам. Створити унікальну етикетку — передусім творче завдання. Підбирати індивідуальне

сполучення властивостей паперу, аналогів якого не буде, розробити стильний дизайн, виконати якісний друк — не просте завдання, оскільки для цього потрібна спільна робота розробників дизайну, виробника етикетки та постачальника паперу. 

   Оскільки офсетним способом друку в Україні друкується 80% всієї про

дукції й комп’ютерні технології основні в додрукарських процесах,тому курсовий проект присвячений розробці дизайну етикеток в комп’ютерних програмах Photoshop та Corel Draw і технологічному процесу виготовлення друкарських форм уку за технологією Computer-to-film.


                                     -5- 

           1.Розробка технічної характеристики продукції, що    


                                 проектується



                                                                                                                               Таблиця 1

	Показники оформлення
	Характеристика продукції

	1. Назва продукції
	Єтикетка “Напій Буратіно”

	2. Розмір етикетки
	70(86 мм

	3. Розробка етикетки
	Замовник приносить готовий логотип на компакт-диску, вибором шрифтів, створенням ілюстрацій, фону займається дизайнер

	4. Тип задрукованого матеріалу
	Самоклеючий папір HERMA weib super 

	5. Графічні елементи етикетки
	Растрова графіка: прези за якість, морозиво, фон, логотип
Векторна графіка: штрих-код, шрифти

	6. Шрифти
	Гарнітури: Arial, 6 п.; 

Arial, 8 п.

	7. Ілюстрації
	Шрифти, растрова графіка, векторна графіка, фон

	8. Монтаж
	Електронний монтаж:

По-ширині —6 фрагментів;

По-довжині — 6 фрагментів;

На формат А2 — 36 фрагментів.

	9. Кольороподіл і фотовивід
	Лініатура — 200 lpi 

Формат фотовиводу — 59,7 см

	10. Кольори
	Система CMYK: жовтий, голубий, пурпурний, контурний

	11. Виготовлення друкарської форми
	Пластина Futura Oro від фірми Lastra spa, позитивного копіювання товщиною 0,30 мм

	12. Спосіб друку
	Офсетний

	13. Устаткування
	Друкарська машина MITSUBISHI серії 3H-2, кількість друкарських секцій — 4, максимальний формат друку — А2.

	14. Кількість назв
	1000

	15. Технологія
	Computer-to-film

	16. Наклад
	150000
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Схема технологічного процесу виготовлення фотоформ для друкування етикеткової продукції

Ознайомлення з оригіналом та бажаннями замовника (текстово-графічний оригінал, півтонові ілюстрації, логотип, шрифти)


Сканування ілюстрацій на сканері IMACON Flextight 2848


Обробка зісканованих ілюстрацій у програмі растрової графіки PhotoShop 9.0 на комп’ютері Intel Pentium IV


Створення векторної частини зображення (графічні об’єкти, тексти, 
штрих-код) у програмі векторної графіки Corel Draw 12
 на комп’ютері Intel Pentium IV


Зведення в оригінал-макет 
растрової та векторної частини зображення

Цифрова кольоропроба

Кольорокорекція


Електронний монтаж згідно специфікації (множення, мітки)


Кольороподіл


Насвітлення монтажу етикеток на плівку Kodak Cian 5 GRD
у фотонасвітлювачі ECRM STINGRAY 63


Проявлення, фіксаж, сушіння 
в проявному процесорі Glunz&Jensen MultiLine 950
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        2.Вибір і обґрунтування прийнятого технологічного  


                            процесу

Технологія Computer-to-film передбачає, що інформаційний масив з комп’ютера записується на фотоплівку, з якої потім виготовляються друкарські форми. При використанні комп’ютерно видавничих систем слід велику увагу звернути на вибір операційної системи, від якої залежить коректна робота видавничої системи в цілому. В даному курсовому проекті вибрано операційну систему Windows XP, яка характеризується відносною стабільністю відносно попередніх версій. Дана операційна система дає змогу організувати локальну мережу у видавництві, що суттєво пришвидшує процес поширення інформації по видавничому комплексу. Крім того для даної операційної системи створено велику кількість програмного забезпечення, що суттєво полегшує процес пошуку і інсталяції програмного забезпечення.

Для складання текстової частини етикетки КП запроектовано програму обробки векторних зображень, при обробці растрових ілюстрації буде використовуватись графічний редактор Adobe PhotoShop 9.0, векторні ілюстрації, а також  складання текстів, векторних та растрових ілюстрацій в готовий макет етикетки виконуватиметься у програмі Corel Draw 12. Ці програмні продукти є одними з найпотужніших поліграфічних програм, якими користуються більшість поліграфічних підприємств світу.

Створення растрових ілюстрацій. В даному макеті етикетки растровими ілюстраціями є зображення “Буратіно”,квіти і листя . Для внесення цих зображеньв комп’ютер використовується процес оцифровки (сканування) зображень. Процес сканування зображень відбувається на барабанному сканері IMACON Flextight 2848. Кольорове зображення зчитується сканером за рахунок сумування трьох складових кольору: червоного, зеленого та синього (координати кольорової системи RGB). 

В цьому сканері оригінал монтується на внутрішній чи зовнішній (в
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 залежності від моделі) стороні прозорого циліндру. Іноді для кращого контакту оригіналу з циліндром використовують вакуум (для слайдів можливе використання спеціальної змазки). Після монтажу барабан приводиться в рух. За один оберт барабана зчитується одна лінія пікселів.

У багатьох моделях барабанних сканерів використовують три фотопомножувачі для одночасного зчитування основних складових кольору за один прохід, В деяких барабанних сканерах виконується трипрохідне сканування одним фото-помножувачем. Використання фотопомножувачів забезпечує більшу чутливість пристрою зчитуванні і значно більшу роздільну здатність сканування. Для того, щоб отримати якісне віддруковане зображення, роздільна здатність при скануванні повинна бути в два рази більшою від лініатури растра при друці.

Щоб розпочати процес сканування після монтування оригіналу слід виконати таку послідовність операцій: 

1. Запустити програмний інтерфейс сканера.

2. Кнопкою Preview запустити попередній перегляд скануючої ілюстрації, вибрати систему колірності (режим сканування) — для даного випадку CMYK, та вибрати роздільну здатність сканування — 400 dpi, оскільки лініатура при друці приблизно рівна 200 lpi.

3. Далі у вікні перегляду зображення слід окреслити приблизну зону сканування зображення і ініціювати попереднє сканування. Щоб більш точно вибрати область сканування в збільшеному вікні фрагменту відкоригувати область та провести остаточне сканування.

4. Зберегти отримані зображення в файлах buratino.tif (буратіно) і malunok.tif (малюнок). Формат TIFF створений фірмою Aldus для зберігання сканованого зображення є дійсно універсальним завдяки великій гнучкості. Важливо зберігати файли в одній і тій самій папці для кращого пошуку.

Обробка файлів. Заскановані файли ще не можна використовувати для відтворення оригіналів оскільки вони ще не пройшли попередньої обробки.

                              -9-

 Для обробки цих файлів КП запроектовано програму обробки растрової графіки Adobe Photo Shop 9.0, яка є незамінним пакетом для обробки, зміни, збереження графічних об'єктів. Попередньо зіскановані файли потребують внесення дизайнером деяких корективів, так наприклад ретуш, корегування рівнів яскравості, світлоти та контрасту для правильної передачі кольорів при офсетному друці.

Для обробки цих файлів слід виконати таку послідовність операцій:

1. З меню “Пуск” запустити програму Adobe Photo Shop 9.0.

2. Завантажити потрібний для обробки файл шляхом виконання команди File > Open.
3. Інструментом Crop ліквідувати можливі перекоси, які могли утворитись при не перпендикулярному розміщення оригіналу в сканері та виконати остаточну обрізку ілюстрацій.
4. Командою Image > Adjust > Levels (комбінація клавіш Ctrl+l) збалансувати рівень тіней, півтонів та контрасту. Після виконання цієї команди відкривається діалогове вікно в якому представлена гістограма поділу пікселів за градаціями яркості.  Слід поставити галочку попереднього перегляду Preview щоб результат корекції було видно без закриття діалогового вікна. В нижній частині гістограми знаходиться 3 бігунки, які відмічають положення чорного, білого та нейтрально-сірого кольорів зображення. Потрібно відкоригувати гаму, тобто рівень середніх тонів для цього слід перемістити середній бігунок. По досягненню необхідного ефекту слід натиснути Ok.
5. Виконати кольорокорекцію для кожного каналу за допомогою кривих співвідношення вхідного та вихідного рівня (команда Image > Adjust > Curves або комбінація кнопок Ctrl+M). В вікні, що з’явиться є графік розподілення пікселів, по осі Х розташовані градації світлоти пікселя, по осі Y результат корекції. По закінченні коригування кольору слід нажати Ok.
6. Після етапу кольорокорекції слід виконати “обтравку” зображення 
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7. для відсікання зайвої частини зображення, для досягнення більшої реалістичності при комбінування з фоном. Даний процес виконується інструментом Pen. Даний інструмент працює за принципом кривих Безьє, тобто векторного шляху. Створивши криву слід замкнути контур, при цьому створюється шлях, який відображається у палітрі Paths і який потрібно зберегти командою Save Path під назвою Path 1 для подальшої роботи з ним. Далі слід перетворити виділений контур на виділену область командою Make Selection… , яка викликиє діалогове вікно де треба вказати радіус виділення (Feather), для надання більшої реалістичності слід ввести знасення 2, бо при значенні за замовчуванням створюються надто різкі контури зображення. Після натиснення кнопки Ok створюється  контур виділення зображення. Далі потрібно інвертувати виділення командаю Select > Inverse. По виконання цієї команди виділиться зайвий фон,  після вирізання якого зображення прийме реальний вид, дещо розмитий по краях.

8. Зберегти файл під тим самим іменем командою File > Save або комбінацією Ctrl+S.
Процес обрізки, ретуші та кольорокорекції слід виконувати для обох сканованих зображень. 

Створення фону. Фон також створюється у програмі Adobe Photo Shop 9.0. Для того щоб створити потрібний фон треба виконати таку послідовність операцій:

1. Запустити програму Adobe Photo Shop 9.0.

2. Командою головного меню File > New відкрити діалогове вікно створення нового зображення. В даному діалоговому вікні слід ввести розмір етикетки ширина 160 см., висота 100 см. та вказати режим колірності зображення CMYK.

3. Далі слід задати градієнтну заливку фону, це можна зробити вибравши інструмент Градієнт та вказавши кольори переходу (колір 
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4. фону білий, колір переходу має характеристики C=8, M=96, Y=100, K=1) провести інструментом вздовж зображення. В результаті одержимо перехід світло червоного кольору в білий. 

5. Після цього треба викликати діалогове вікно фільтру ЗігЗаг (команда Filters > Distort > ZigZag). В діалоговому вікні що відкриється треба ввести параметри: стиль — Around Center, повзунок Amount — 100 %, а повзунок Ridges — 2 % та натиснути Ok. В результаті ми отримаємо фонове зображення в виді скручених смуг білого кольору.

6. Командою File > Save As зберегти файл у папці з обробленими зображеннями під назвою fon.tif.

По закінченні етапів обробки зображень та створення фону можна перейти до етапів створення секторних елементів та створення текстової частини етикетки.

Створення векторної частини зображення. КП запроектовано для створення векторної частини зображення, штрих-коду та формування макету етикетки  програму обробки векторної графіки Corel Draw 12. 

В інсталяційний пакет програми входять наступні програми:

1. Corel Draw — редактор векторних зображень, який пропонує потужні засоби розробки, широкий спектр інструментів для побудови об’єктів, сучасні ефекти, а також високоякісні засоби виведення.

2. Corel PHOTO-PAINT — програма для обробки растрових зображень.

3. Corel R.A.V.E. — для створення векторної анімації.

4. Microsoft Visual Basic for Applications — засіб, котрий дозволяє розробникам швидко будувати підпрограми з різних компонентів інших програм, щоб задовольнити будь-які, найспецифічніші потреби користувача, використовуючи для цього просту і дуже популярну сову програмування.
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5. Canto Cumulus Desktop — засіб організації і управління мультимедійною інформацією, котрий дозволяє організувати легкі в управлінні каталоги файлів різного типу. Програма підтримує більше 110 форматів файлів.

6. Bistream Font Navigator 4.0 — адміністратор шрифтів для Windows 9x NT, розроблений корпорацією Bistream Inc.

7. Corel BARACODE WIZARD — майстер для створення штрих-кодів.

8. Corel TRACE — утиліта перетворення растрових зображень у векторні.

9. Corel CAPTURE — утиліта для захоплення зображення з екрану, котра володіє широким набором функцій.

10.  Corel TEXTURE — засіб для створення різноманітних текстур, котрі імітують різноманітні природні матеріали, а також різнорідних власних текстур.

Створення векторного тексту. Тексти майбутньої етикетки і цифри штрих-коду надаються замовником. Тексти набираються інструментами  Text і Pick. При зберіганні текстів можуть виникнути проблеми з шрифтами, щоб уникнути цієї незручності потрібно тексти перетворити в криві.

Текстова частина етикетки набирається згідно технічних правил складання простого тексту та тексту з виділеннями.

Графічний редактор Corel Draw має у своєму розпорядженні інструменти для обробки текстів. Його можливості хоча і не такі великі і не такі зручні в роботі, як у професійних видавничих систем і могутніх текстових редакторів, але все-таки достатні для вирішення багатьох задач.

Corel Draw дозволяє створювати текстові об'єкти двох типів: нормальний текст (Paragraph) і артистичний текст (Artistic).

Артистичний текст в основному служить для створення красивого оформлення продукції. При цьому рамки тексту не обмежені - досить один раз клацнути в будь-якім місці екрана - і можна вводити текст. В міру набору границі об'єкта будуть розширюватися автоматично.
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Для уведення великої кількості тексту краще використовувати формат Paragraph. При створенні об'єкта потрібно вказати ту область на листі, у якій буде розміщатися текст. При заповненні всієї рамки текстом, він не буде виводитися на екран. Потрібно або розширити границі, або перенести ту частину, що не влізла, в інший об'єкт Paragraph.

З об'єктом тексту можна робити різні ефекти, використовуючи команди з меню Effects: масштабування, розтягування, стиск, перекіс, обертання. Як і будь-яка програма, що працює за принципом WYSIWYG, Corel Draw наочно відображає всі зміни тексту на екрані. Редактор дозволяє використовувати усі встановлені шрифти Windows типів True Type і Post Script 1.

Всі тексти етикетки повинні набиратись окремими текстовими блоками. Для створення нового текстового блоку клікаємо інструментом Text на робочому полі. Для задання виключки, гарнітури та кеглю шрифта потрібно скористатись панеллю властивостей шрифта (попередньо потрібно виділити текстовий блок інструментом Pick). В результаті набору і форматування утворяться і текстові блоки. 

Далі виділяємо всі текстові блоки і перетворюємо тексти в криві з допомогою команди контекстного меню виділених об’єктів Convert To Curves.

Створення штрих-коду. Для створення стрічки штрих-коду необхідно скористатися додатком до програми Corel Draw під назвою Corel Barcode Wizard. Після виклику цього додатку необхідно обрати промисловий стандарт EAN-13 та ввести перші дванадцять цифр коду. При цьому автоматично рахується тринадцята контрольна цифра (в даному випадку  ). Після натискання кнопки Next з’являється наступний запит, де потрібно встановити такі параметри: роздільна здатність принтера — 2400 dpi, одиниці — mm. Інші параметри залишити такими , що встановлені за замовчуванням. Після натискання кнопки Next з’являється останню вікно, де необхідно дозволити “читаність” (відображення його чисельного 
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значення) і натиснути Ok. Код буде скопійований у буфер обміну, звідки його необхідно вставити на сторінку та зберегти у файл з іменем barcode.eps.

Зведення в оригінал-макет растрової та векторної частини зображення. Коли всі елементи етикетки готові можна приступити до їх зведення в оригінал-макет майбутньої етикетки. Для цього КП запроектовано скористатись програмою Corel Draw. Для того, щоб отримати готовий оригінал-макет етикетки потрібно виконати таку послідовність операцій:

1. Запустити програму Corel Draw і в діалоговому вікні вибрати пункт “Новий”, в результаті створиться новий документ.

2. Вставити у новий файл створений в Corel Barcode Wizard штрих-код.

3. Командою File > Import імпортувати збережені файли fon.tif (файл з фоном), buratino.tif (буратіно), malunok.tif (малюнок).

4. Командою File > Open відкрити файл з текстами. Скопіювати текстові блоки командою Copy  і вклеїти їх командою Poste у файл з імпортованими зображеннями.

5. Користуючись інструментом Pick потрібно розмістити зображення фону, персиків, морозива, штрих-коду, логотипа замовника (логотип надається замовником на компакт-диску), а також текстові блоки відповідно до макету.

6. Зберегти новостворений файл у папці з попередньо створеними файлами під назвою etuketka.cdr.

Кольоропроба. Високі вимоги до якості поліграфічної продукції спричинилися до значного розвитку об'єктивних засобів контролю технологічних операцій поліграфічного виробництва. На сьогодні розроблена і використовується значна кількість методів і відповідного обладнання для контролю якості виконання тієї чи іншої операції.

В даному КП запроектовано цифрову кольоропробу, в якій найчастіше
                                                 -15-

 в якості кольоровивідних пристроїв використовуються принтери. Більшість цифрових принтерів базується на кольорах CMYK, тому вони зможуть повністю відтворити запроектовану колірністю етикетки.

У струминних принтерах застосовуються чорнила на водній або водно-спиртовій основі, а тому потрібно використовувати спеціальний папір для одержання якісних відбитків з точною передачею кольору, різкістю, насиченістю. Крім того на якість зображення впливає розбризкування фарби під час удару об папір, що призводить до поганої передачі штрихових елементів зображення та зниження чіткості зображення.

Однак, струминні принтери мають значну перевагу — це відносно низька вартість відбитка при достатньо високій швидкості друку і можливість виконання чорнових робіт на звичайному папері.

Застосування технології цифрової кольоропроби є найефективнішим, коли програмне забезпечення, яким обробляються зображення, працює з стандартизованою системою кольорів, такою, як Pantone чи TrueMatch.

Виконання контрольної кольоропроби пов'язане з необхідністю узгодження кольорів видання з замовником і налагоджуванням фарбового апарату друкарської машини друкарем, як і дотримання ним у процесі друкування необхідного співвідношення кольорів на відбитку. 

На кольоровому відбитку слід візуально оцінити співвідношення кольорів, крім того на роздрукованому макеті етикетки потрібно перевірити правильність набору та розміщення всіх елементів етикетки. Якщо потрібно то в електронний макет вносяться електронні правки.

Дизайнерське оформлення етикетки можна завершити після підписання остаточного макету замовником.

Електронний монтаж.  Важливе й особливе значення у процесі репродукування має монтаж фотоформ, тобто з’єднання окремих частин (фотоформ) в єдине ціле. У зв’язку з бурхливим розвитком цифрових систем оброблення інформації з програмним керуванням від персональних комп’ютерів, монтаж також здійснюють електронними засобами на 
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моніторі до виготовлення фотоформ, які виводять вже на фотоплівку після закінчення монтажу. В даному курсовому проекті запроектовано електронний метод монтажування. Електронний монтаж здійснюють у програмі векторної графіки Corel Draw. Для того, щоб зробити монтаж треба у даній програмі створити аркуш паперу формату А2 (орієнтація альбомна) і завантажити електронний макет етикетки. Далі копіюємо згрупований макет і вставляєм 15 копій на аркуш, так щоб по ширині розмістити 5 фрагментів, а по висоті 3 фрагменти, при цьому по 30 мм. зверху і знизу, а також 17 мм. зліва і справа залишаємо на захват друкарської машини. Ширина між етикетками по горизонталі 40 мм., по вертикалі 15 мм.

В результаті електронного монтажу ми одержимо наступний макет розміщення фрагментів етикетки:
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Якість і правильність електронного монтажу контролюють візуально на екрані монітора системи або за твердою копією здобутою на принтері.

Кольороподіл.  Кольороподіл — це поділ зображення оригіналу за допомогою світлофільтрів або селективних джерел освітлення на окремі одноколірні рівномасштабні зображення. При синтезі кольорового зображення на відбитку в процесі друкування кольороподілених однофарбових друкарських форм із певною точністю відтворюють кольорове зображення. 

Комп’ютерний кольороподіл — це кольороподіл, що здійснюється автоматизованими оптоелектронними засобами за допомогою КВС. З їх створенням комп’ютерний кольороподіл все більше витісняє класичний 
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 кольороподіл на основі аналогових електронних або аналогових оптичних систем, забезпечуючи невпинне підвищення якості кольороподілу. В даному курсовому проекті запроектовано електронний кольороподіл при якому зображення програмним шляхом розбивається на 4 складові для жовтої, голубої, пурпурної та контурної фарби.

Насвітлення монтажу етикеток. Насвітлення відбувається у фотонасвітлювачі ECRM STINGRAY 63 при лініатюрі 200 lpi. Даний фотонасвітлювач має вмонтований програмний RIP, тому процес растрування відбувається автоматично завдяки спеціальній програмі, що поставляється у стандартній комплектації разом з фотонасвітлювачем. Програмний (зовнішній) RIP діє на базі однієї зі стандартних ком​п'ютерних платформ PC, Мас чи Spare, при цьому, окрім растрування даних, може виконувати і додаткові завдання. Крім того даний фотонасвітлювач має наявність пробивання системи штифтових отворів, яка дає можливість подальшого використання проекспонованих плівок при експонуванні пластин без додаткового монтажу. Далі фотоформа проходить хімічну обробку в проявляючому процесорі Glunz Jensen MultiLine 950, який з’єднаний з фотонасвітлювачем в On-line лінію, що автоматизує подання пластин з фотонасвітлювача на хімічну обробку.
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3. Вибір, обґрунтування і коротка характеристика 

  
      запроектованого обладнання

В даному курсовому проекті в якості робочої станції для підготовки оригінал-макету етикетки запроектовано комп’ютер на базі процесора Intel Pentium IV з тактовою частотою 2,60 GHz. Даний процесор за своїми технічними характеристиками значно перевищує характеристики попередніх моделей, завдяки цьому він може з легкістю справлятись з будь-якою поставленою задачею: від обробки текстів до найскладнішого електронного монтажу та кольороподілу. Це дає змогу використовувати даний комп’ютер у всіх запроектованих КП технологічних операціях пов’язаних з електронною підготовкою оригінал-макету етикетки.

Даний комп’ютер підключається до монітора MITSUBISHI Diamond PRO 93 SB. Diamond PRO 93 SB — монітор від відомого на сьогоднішній день виробника електронних трубок Diamondtron. Традиційно продукти цієї марки досить дорогі так як належать до професійного класу але ціна по відношенню до високої якості зображення відносно невисока. Антиблікове покриття трубок даного монітора також є дуже хорошим. Крім того даний монітор має строгий але дуже симпатичний дизайн.

Для сканування ілюстрацій даним КП запроектовано барабанний сканер IMACON Flextight 2848. Даний сканер позбавлений скла для  сканування на відображення до формату А3+ і на просвіт. Оснащений віртуальним барабаном для слайдів і електростатичним столом для непрозорих оригіналів він забезпечує найкраще сканування без дисперсії, властивій склу, високоякісну обробку негативів і унікальну різкість зображення.

FlexTight 2848 не використовує технологію XYZ, прийняту багатьма виробниками сканерів як вимога майбутнього. Це свідоме відмовлення від
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 використання олії, оскільки процес монтування і наступного очищення слайдів вимагає істотних тимчасових витрат і знижує загальну продуктивність праці перевантажених замовленнями бюро по скануванню. Тому використання віртуального барабана виключає відразу два неприємних моменти - дисторсію на склі і “масляну” процедуру. В остаточному підсумку користувач одержує високу продуктивність при максимальній якості.
Для виведення коректурних відбитків КП запроектовано струменевий принтер Hawlett Packard DeskJet 815C. Даний принтер забезпечує відмінну якість кольорового друку, при високій швидкості друку та чудовій чіткості зображення. Принтер даної моделі є відносно компактним та практично безшумним. Пігментні чорнила, які використовуються при друці швидко висихають і не розмазуються, забезпечуючи високі результати друку та чудову кольоропередачу.Для насвітлення монтажу етикеток на фотоплівку запроектовано фотонасвітлювач ECRM STINGRAY 63. Фотонасвітлювачі Stingray є найкращими по співвідношенню ціна / якість / продуктивність серед усіх 8-сторінкових фотонасвітлювачів представлених на ринку в даний момент. Ключовими властивостями фотонасвітлювачів серії Stingray, що вигідно відрізняють їх від моделей конкурентів, є якість і формат. Якість експонування досягається за рахунок використання удосконаленої оптичної системи з одним напівпровідниковим лазером видимого червоного діапазону (670 нм) зі змінюваною апертурою променя. Крім того, моделі Stingray, як і Marlin, завдяки убудованій системі двох буферів мають можливість підключення до проявляючої системи OnLine, без додаткових витрат на мости і пристрої сполучення (поставляються в стандартній комплектації). Наступною чудовою якістю апаратів даної серії є формат фотовиводу, максимальна величина якого по ширині складає 63 см (Stingray 63), що дозволяє здійснювати фотовивід восьмисторінкової брошури (вісім смуг формату A4 із приводними хрестами). У залежності від бажання 
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замовника апарати поставляються із системою пробивання штифтових отворів (Punch Syst.) чи без неї. Можлива також комплектація ФНА системою пробивання отворів, виготовленої за вимогою замовника. Наявність системи пробивання штифтових отворів у конфігурації ФНА має на увазі подальше використання проекспонованих плівок при експонуванні пластин без додаткового монтажу. Програмний RIP на базі Harlequin PostScript Level 3 дає можливість користувачу з будь-яким ступенем підготовки легко освоїти й експлуатувати цей апарат.
Для хімічної обробки насвітленої фотоплівки запроектовано процесор Glunz Jensen MultiLine 950. Даний процесор з’єднується з фотонасвітлювачем в On-line лінію. Основною перевагою моделей є простота і ефективність роботи. Вибір програм проводиться швидко з допомогою клавіатури на передній панелі процесора. Панель програмування режимів захищена від несанкціонованого доступу. Валики системи протяжки плівки виготовленні із високоякісної резини і зібрані в секції. Секція легко виймається з приладу, а валики з секції, що пришвидшує і полегшує виконання профілактичних робіт
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Таблиця 2

Технічна характеристика запроектованого обладнання

	Назва
	Марка, модель
	Призначення
	Технічна характеристика

	1
	2
	3
	4

	Комп’ютер
	Intel Pentium IV
	Обробка растрових та векторних об’єктів, електронне монтажування
	Тактова частота 2,60 GHz
Чіпсет Intel i875p для Pentium 4

Оперативна пам’ять — 512 MB
Вінчестер —  Seagate 160 GB, 8MB
Відеокарта — Radeon 9800, 128MB
CD-RW — LG 52(24(52

Корпус — MiddleTowerATX 300Вт

	Монітор
	MITSUBISHI Diamond PRO 93
	виведення зображення з комп’ютера
	Тип кінескопа — апертурна решітка

Діагональ — 19 дюймів 
Частота кадрової розвертки в режимі 1280(1024 складає 89 Hz

Частота кадрової розвертки в режимі 1600(1200 складає 76 Hz

	Принтер
	Hawlett Packard DeskJet 815C
	вивід коректурних відбитків
	Формат — А4

Розділ. здатність — 600(600 dpi

Пам’ять — 2 Мб

Швидкість друку:

чорно-білі — 7,5 ст./хв.

кольорові — 5 ст./хв.

Габарити — 355(446(185 мм.
Вага — 5,5 кг

	Сканер
	IMACON Flextight 2848
	сканування ілюстрацій, негативів, слайдів, фотографій
	Оптична роздільна здатність 960-6800 dpi 

Оригінали на відбивання/на просвіт 
Формат відбитку 312х445 мм 

Просвіт від 35 мм до 12х17 см 

Масштабування 20-3200% 

Діапазон щільностей 3.9 D 

Оптична щільність 4.8 Dmax 

Глибина кольору 16 біт/колір 

Колірність 42/56 біт (RGB/CMYK) 

Інтерфейс FireWare 

Електроживлення 100-240В, 50 Гц 

	Фотонасвітлювач
	ECRM STINGRAY 63
	насвітлення монтажу етикеток на фотоплівку
	Максимальна область експонування — 635 мм (25,0Ф)

Джерело випромінювання — червоний лазерний діод 10 mW (довжина хвилі 670 нм)

Розмір точки — 10 – 35 мікрон

Роздільна здатність експонування — 12 стандартних значень від 1000 до 3556 dpi

Максимальна лініатюра растру — 200 lpi

Швидкість експонування — від 81,28 екз/хв (при роздільній здатності 1000 dpi) до 9,37 екз/хв (при роздільній здатності 3556 dpi)

Тип оброблюваного матеріалу — червоночутливі плівки, папери, поліетиленові пластини

Товщина оброблюваного матеріалу — 0,1 – 0,2 мм

Ємність касети — 120 м (матеріал товщиною 0,1 мм)

Система перфорації — можливість вибору однієї з восьми стандартних типів перфорації по широкій чи вузькій стороні

Розміри Ч99х89х112 см

Маса — 368 кг

Живлення — 230V, 50Hz

	Процесор
	Glunz&Jensen MultiLine 950
	хімічна обробка фотоплівки
	Швидкість, см/хв. — 87

Час проявлення від “сухого до сухого”, сек. — 93

Діапазон часу проявлення, сек. 15-60

Об’єм баків:

Проявник 21 л.

Фіксаж 22 л.

Промивка 18 л.

Діапазон температур:

Проявник 20-50 л.

Фіксаж 20-50 л.

Сушка 20-70 л.

Габарити, см 102,5(18,5(21,5

Маса 200

Потужність 6,8
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4.Вибір і обґрунтування матеріалів, що використовуються на дільниці

В даному курсовому проекті запроектовано такі матеріали:

1. CD-RW — компакт диск фірми LG об’ємом 700 MB

2. дискети фірми Verbatim 1,44 MB

3. картриджі з фарбою для принтера HP
4. папір для виготовлення коректурних відбитків фірми BialyKruk форматом А4 (210x297 мм) і масою 80 гр/м2 

5. фотоплівка Kodak Cian 5 GRD (650-680 мм.)

6. проявник для плівки Kodak RA 2000 (1:4)

7. фіксаж для плівки Kodak RA 3000 (1:3)

Для виготовлення коректурних відбитків КП запроектовано папір фірми BialyKruk форматом А4 (210x297 мм) і масою 80 гр/м2
Насвітлення відбувається на фотоплівку Kodak Cian 5 GRD (650-680 мм.), яка має високий D-max і низький D-min. Це комбінаційна висококонтрасна, чутлива до червоного світла плівка для фотонасвітлювачів і плотерів, які використовують для експонування гелій-неоновий лазер і червоний лазерний діод. Основа даної плівки має товщину 0,10 мкм. Плівка засвітлюється при темно-зеленому світлі або при повній темноті. Для обробки плівки запроектовано проявник для плівки Kodak RA 2000 (1:4) та фіксаж для плівки Kodak RA 3000 (1:3).

Етикетка, яка запроектована курсовим проектом для розробки буде клеїтись на відерце з морозивом, тому в якості задруковуючого матеріалу обрано самоклеючий папір HERMA weib super. Самоклеючі етикетки дедалі більше привертають увагу фахівців. На ринку їхня частка вже сягнула 30 %. Сьогодні вони користуються популярністю навіть в тих галузях, які раніше не були традиційними для етикетки (косметика, фармацевтична індустрія тощо). Тому в даному курсовому проекті етикетковий папером вибрано самоклеючий папір. На українському ринку імпортного паперу провідні позиції займає фінська паперова продукція. Проте, найчастіше це пов’язано 
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не з найкращими показниками, а з географічною близькістю, яка дозволяє отримувати значну економію на транспортних витратах. Подібна ситуація донедавна спостерігалась із самоклеючими матеріалами. Однак, сьогодні українські друкарні вже добре знайомі й з більш якісними самоклеючими матеріалами інших виробників — “HERMA” (Німеччина), CYG PRODUCTS (Іспанія) тощо.

“HERMA” виготовляє самоклеючі матеріали за допомогою найсучасніших виробничих процесів, намагаючись задовольнити вимоги ринку. Запровадження найновіших самоклеючих матеріалів і відповідність високим критеріям якості є основними умовами для задоволення побажань споживачів. 

Це білий чистоцелюлозний напівглянцевий папір HERMA weib super (сорт 240) з однобічним машинним крейдуванням. Його клейовий шар може бути різним . у стандартному виконанні пропонується постійний акриловий клей HERMA 62D, який використовується для рівних та злегка жорстких поверхонь. Підкладковий папір може кремового кольору — силі кований та каландрований (TCF) з масою 60 г/м2.

Самоклеючий папір HERMA weib super чудово зарекомендував себе у процесі обробки, оскільки має непогані характеристики для висічки на всіх наявних плоских та ротаційних висікальних машинах та без будь-яких ускладнень задруковується всіма класичними способами друку.
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   5.Розробка технологічного процесу за основними операціями

   Таблиця 4

	№


	Виконувана операція
	Устаткування та інструменти, що використовуються на дільниці
	Матеріали, які використовуються на дільниці
	Технологічний режим
	Виконавець

	
	1
	2
	3
	4
	5

	1
	Ознайомлення з оригіналом та бажаннями замовника
	Олівець, ручка
	Папір, CD
	ручний
	дизайнер

	2
	Сканування ілюстрацій
	Сканер IMACON Flextight 2848
	Каталог на CD
	автоматичний
	дизайнер

	3
	Обробка зісканованих ілюстрацій
	Комп’ютер Intel Pentium IV
	Програма растрової графіки PhotoShop 7.0
	діалоговий
	дизайнер

	4
	Створення векторної частини етикетки
	Комп’ютер Intel Pentium IV
	Програма векторної графіки Corel Draw 11
	діалоговий
	дизайнер

	5
	Вивід коректурного відбитка
	Струменевий принтер
	Папір, тонер
	автоматичний
	дизайнер

	6
	Колорокорекція
	Комп’ютер Intel Pentium IV
	Програма растрової графіки PhotoShop 7.0
	діалоговий
	дизайнер

	7
	Електронний монтаж
	Комп’ютер Intel Pentium IV
	Програма векторної графіки Corel Draw 11
	діалоговий
	дизайнер

	7
	Насвітлення монтажу етикеток на плівку
	фотонасвітлювач ECRM STINGRAY 63
	Фотоплівка Kodak Cian 5 GRD 
	автоматичний
	Копіювальник 6 розряду

	8
	Проявлення, фіксаж, сушіння
	проявний процесор 
Glunz& Jensen MultiLine 950
	Проявник Kodak RA 2000 (1:4); фіксаж Kodak RA 3000 (1:3)
	автоматичний
	Копіювальник 6 розряду
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